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[bookmark: _Toc379814218]Εισαγωγή
Το παρόν εγχειρίδιο έχει στόχο να παρέχει στον χρήστη τις απαραίτητες πληροφορίες & τεχνικές για την μετα-παραγωγή οπτικο-ακουστικού υλικού. Το εγχειρίδιο συντάχθηκε στα πλαίσια του έργου «Ανοιχτά Ψηφιακά Μαθήματα», και παρέχεται δωρεάν στα πλαίσια του παραπάνω αναπτυξιακού έργου με στόχο την κατάρτιση των τεχνικών συνεργατών που συμμετέχουν στα Πανεπιστημιακά τμήματα.
[bookmark: _Toc379814219] 
[bookmark: _Toc379814220]1.	Χαρ/κα ψηφιοποίησης
 Ένα μεγάλο μέρος του ψηφιακού υλικού που αντλείται από τα ψηφιακά μαθήματα είναι η παραγωγή των βιντεο-διαλέξεων. Λόγω των συνθηκών ηχογράφησης και μαγνητοσκόπησης σε αρκετές περιπτώσεις απαιτείται επεξεργασία του ψηφιακού αυτού υλικού. Η επεξεργασία χωρίζεται σε δύο μέρη: στο μοντάζ για το βίντεο και στην μίξη για τον ήχο. 
Πρέπει να τονίσουμε εξ’ αρχής ότι δεν είναι στόχος του παρόντος εγχειριδίου να καλύψει όλη την θεματολογία και τις τεχνικές της επεξεργασίας βίντεο και ήχου, καθώς ο όγκος πληροφοριών είναι πάρα πολύ μεγάλος. Στο παρόν εγχειρίδιο παρουσιάζονται και αναλύονται, σε απλουστευμένη μορφή η θεωρία και οι βασικές τεχνικές επεξεργασίας έτσι ώστε να μπορούν να χρησιμοποιηθούν από τους εκάστοτε τεχνικούς των πανεπιστημιακών ιδρυμάτων για τις ανάγκες του προγράμματος των «Ανοιχτών Ψηφιακών Μαθημάτων». Αν χρειαστεί περαιτέρω εμβάθυνση στα παρακάτω αντικείμενα  προτείνεται στο Παράρτημα επιπλέον βιβλιογραφία και πηγές στο διαδίκτυο. Όλες οι τεχνικές επεξεργασίας που αναλύονται έχουν κριθεί απαραίτητες σύμφωνα με τις απαιτήσεις, τις συνθήκες χρήσης και του software εξοπλισμού που έχουν μελετηθεί για το έργο. Ωστόσο δεν είναι απαραίτητη η εφαρμογή όλων των παρακάτω τεχνικών, καθώς κάθε περίπτωση μπορεί να διαφέρει αλλά και ο τεχνικός ενδέχεται να χρησιμοποιεί διαφορετικές εφαρμογές. 
Πρέπει να τονίσουμε τέλος ότι η γενική φιλοσοφία γύρω από το μοντάζ και τη μίξη βασίζεται στην αντιληπτική και αισθητική ικανότητα του χρήστη.
[bookmark: _Toc379814221]1.1	Ιδιότητες – Χαρακτηριστικά Video - Audio
Προτού προχωρήσουμε στις τεχνικές επεξεργασίας είναι απαραίτητο να αναφέρουμε τα χαρακτηριστικά της ψηφιοποίησης που καθορίζουν το υλικό μας. Κατά την επεξεργασία ψηφιοποιημένου Video και Audio πρέπει να ληφθούν υπόψη τα εξής χαρακτηριστικά.
[bookmark: _Toc379814222]1.1.1	Frame Rate (fps) 
Το frame rate δηλώνει τα frames/καρέ της εικόνας ανά δευτερόλεπτο. Προφανώς όσο περισσότερα είναι τα καρέ ανά δευτερόλεπτο τόσο καλύτερα για το ανθρώπινο μάτι. Τα FR που χρησιμοποιούμε είναι στο ευρωπαϊκό πρότυπο DV-PAL 25 fps και στα Multimedia 15 fps. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η τιμή του FR να ορίζεται στα 20 fps. Στις κινηματογραφικές παραγωγές HD το FR είναι πάνω από 30 fps.
[bookmark: _Toc379814223]1.1.2	Bit Rate (kpbs)
Είναι η ροή δεδομένων της εικόνας σε video το οποίο είναι συμπιεσμένο με κάποια κωδικοποίηση (mp4, wmv κλπ). Όσο μεγαλύτερο είναι τόσο πιο ευκρινής θα είναι η εικόνα μας στον χρόνο (δεν θα pixel-λιάζει). Συνήθως για multimedia παραγωγές το Bit Rate κυμαίνεται από 200 kbps – 600 kbps. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η τιμή του bit rate να ορίζεται στα 750 kbps. Για παραγωγές τύπου ταινιών υπερβαίνει τα 2 Mbps.
[bookmark: _Toc379814224]1.1.3	Ανάλυση (pixel)
Η ανάλυση δηλώνει το κάδρο διαστάσεων του video σε pixel. Οι διαστάσεις των κάδρων ποικίλουν από σύστημα σε σύστημα. Επίσης λαμβάνουμε υπόψη την αναλογία ύψους-πλάτους και το pixel aspect ratio το οποίο είναι πρότυπο για κάθε σύστημα. Οι βασικές αναλύσεις που χρησιμοποιούμε στο ευρωπαϊκό πρότυπο PAL-DV και πολυμέσα είναι: 720x576 & 640x480. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η ανάλυση SHD 1280 x 720.  Στο πρότυπο HD οι αναλύσεις είναι πολύ μεγαλύτερες.
[bookmark: _Toc379814225]1.1.4	Sample Rate (Hz)
Sample Rate ονομάζουμε τον ρυθμό λήψης ψηφιακών δειγμάτων για ένα απαιτούμενο εύρος συχνοτήτων. Το Audio CD έχει πρότυπο Sample Rate 44.1 kHz. Σε multimedia παραγωγές που έχουμε λιγότερα στοιχεία όπως ομιλία το SR μειώνεται στα 22.05 kHz. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η τιμή του sample rate να ορίζεται στα 44100 Hz.
[bookmark: _Toc379814226]1.1.5	Bit Rate (kbps) 
(Συμπιεσμένα αρχεία ήχου): Όπως και στο video έτσι και στον ήχο έχουμε την ροή δεδομένων κατά την συμπίεση. Για προδιαγραφές streaming ο stereo ήχος τοποθετείται από 54 – 96 kbps. Για πιο απαιτητικές παραγωγές ο ήχος τοποθετείται στα 128 – 192 kbps (ποιότητα CD). Να ληφθεί υπόψη ότι κατά την τελική εξαγωγή ενός video αρχείου το τελικό bit rate είναι το άθροισμα bit rate των παραπάνω δύο. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η τιμή του audio bit rate να ορίζεται στα 128 kbps.  
[bookmark: _Toc379814227]1.1.6	Bit depth (bit)
Το bit depth ή στα ελληνικά η ανάλυση του ψηφιοποιημένου δείγματος, αντιπροσωπεύει το εύρος ψηφιοποίησης στην ένταση ενός κύματος, χωρίς συμπίεση των δεδομένων. Με διαφορετικά λόγια είναι ο αριθμός των υποδιαιρέσεων που μπορεί να ψηφιοποιηθεί η ένταση της κυματομορφής. Το audio CD έχει πρότυπο τα 16 bit και το DVD τα 24 bit. Κατά την ηχογράφηση θέτουμε σαν ελάχιστο όριο ανάλυσης τα 16 bit.
 



[bookmark: _Toc379814228]2.	Βίντεο
	Για την επεξεργασία οπτικού υλικού χρησιμοποιούμε στην περίπτωση μας το λογισμικό Sony Vegas για παραγωγή βίντεο. Όλες οι τεχνικές εφαρμόζονται παρόμοια και σε άλλα λογισμικά παραγωγής βίντεο.
[bookmark: _Toc379814229]2.1	Χρήση του Vegas – import αρχεία
Ανοίγουμε το Sony Vegas και εισάγουμε τα αρχεία μας με drag & drop αρχικά στο panel project media. Έπειτα με την ίδια μέθοδο εισάγουμε τα αρχεία μας στη μπάρα επεξεργασίας (timeline). Με κάθε εισαγωγή δημιουργούνται τα αντίστοιχα tracks τα οποία περιέχουν τα μέρη που θα επεξεργαστούμε. Κάθε αρχείο ψηφιοποιημένου οπτικοακουστικού υλικού περιέχει ένα μέρος video και ένα μέρος audio. Κατά την εισαγωγή του αρχείου στον άξονα εργασίας τα δύο μέρη είναι συγχρονισμένα και ομαδοποιημένα μεταξύ τους και εμφανίζονται με την μορφή συμβάντων (clips).
[image: ]
Εικόνα 1. Τοποθέτηση ενός clip στον άξονα εργασίας (timeline)
[bookmark: _Toc379814230]2.2	Tracks
	Πάνω στο timeline τα συμβάντα (clips) παίρνουν την θέση τους μέσα σε κανάλια (tracks). Ο αριθμός των tracks εξαρτάται από τον χρήστη, τον αριθμό των clip που θα εισάγει και τις ιδιότητες τους. Έτσι δουλεύουμε σε ένα σύστημα πολύ-κάναλο όπου κάθε κανάλι (audio & video) έχει τις δικές του ρυθμίσεις.
[image: ]
 Εικόνα 2. Βασικές λειτουργίες των καναλιών.
Συνοπτικά οι λειτουργίες ενός track είναι:
· Όνομα: Το όνομα του καναλιού. Εξυπηρετεί να δίνουμε ονόματα στα tracks όταν δουλεύουμε με πολλαπλά κανάλια.
· Solo function: Η λειτουργία αυτή απενεργοποιεί όλα τα υπόλοιπα κανάλια αντίστοιχου είδους και κρατάει ενεργό μόνο το επιλεγμένο. Μπορεί κάποιος να κάνει solo πάνω από ένα κανάλι.
· Mute function: Η λειτουργία αυτή απενεργοποιεί αυτό το κανάλι. Πχ. στην περίπτωση του ήχου δεν περνάει το σήμα στο Master Track.
· Εφέ: Σε αυτό το panel ανοίγει ένα dialog για την προσθήκη οπτικών ή ψηφιακών εφέ.
· Στάθμη έντασης (audio) ή opacity (video): Αλλαγή της στάθμης καθολικής έντασης ή opacity αντίστοιχα για το συγκεκριμένο track.
Γενικά ισχύει η εξής λογική με τα πολλαπλά tracks. Για την περίπτωση του video υπερισχύει-φαίνεται στην κεντρική οθόνη το video track που βρίσκεται ψηλότερα από όλα τα tracks. Φυσικά αυτό ισχύει αν το opacity βρίσκεται στο 100 %.  Εάν ένα track έχει μικρότερο ποσοστό opacity τότε η εικόνα αναμειγνύεται (blending-compositing) με το αμέσως επόμενο σε σειρά προς τα κάτω. 
 
[bookmark: _Toc379814231]2.3	Navigation - Editing – Trimming
[bookmark: _Toc379814232]2.3.1	Μετακίνηση Clip στον άξονα του χρόνου (Navigation)
Εισάγοντας ένα clip σε ένα κανάλι, αυτό θα βρίσκεται σε μια συγκεκριμένη θέση στον χρονικό άξονα. Έχουμε φυσικά την δυνατότητα να μετακινήσουμε ολόκληρο το clip στον άξονα του χρόνου σε σχέση με τυχόν άλλα clip τα οποία βρίσκονται σε άλλα κανάλια. Αυτό απλά γίνεται με το να σύρουμε το clip, κρατώντας με το ποντίκι. Οι λόγοι μετακίνησης είναι πολλοί. Είναι βολικό αρκετές φορές να μετακινούμε τα clips ομαδικά κοντά στην αρχή του timeline. Ακόμη μπορεί να χρειαστεί να αλλάξουμε την χρονική σειρά με την οποία διαδέχεται ένα clip το άλλο ή εάν πρέπει να καθυστερήσει ένα clip σε σχέση με ένα άλλο. Γενικά η μετακίνηση clip στα κανάλια στον άξονα του χρόνου είναι από τις στοιχειώδεις διαδικασίες στο editing. Επιπρόσθετα κρατώντας το Shift ή το Ctrl μπορούμε να επιλέξουμε πολλά ή συγκεκριμένα αντίστοιχα clip για ομαδική μετακίνηση.
 [image: ]
Εικόνα 3. Μεταφορά ενός clip στην αρχή του timeline
[bookmark: _Toc379814233]2.3.2	Editing – Αποκοπή μερών clip - Trimming
Είναι απαραίτητο αρκετές φορές να αποκλείσουμε κομμάτια από μία διάλεξη τα οποία είναι περιττά ή ανεπιθύμητα. Σε αυτήν την περίπτωση απλά χρειάζεται να κόψουμε το επιθυμητό κομμάτι. 
Για να κόψουμε ένα κομμάτι από το video, χρειάζεται να κάνουμε τομή σε δύο σημεία. Διαλέγουμε τα σημεία που θέλουμε να κάνουμε τη τομή και πατάμε το πλήκτρο  “S”. Επιλέγοντας ένα κομμάτι βίντεο που κόψαμε, μεταξύ των δύο σημείων τομής και πατώντας  το πλήκτρο “Delete” το διαγράφουμε. Σημείωση: ένα video clip είναι by default ομαδοποιημένο με το αντίστοιχο audio clip. Έτσι εάν κάνουμε μια τομή στο βίντεο αντίστοιχα θα γίνει και μια τομή στο κομμάτι audio ώστε η αφαίρεση να γίνει ομοιόμορφα. Σε πιο απαιτητικές συνθήκες ξεχωρίζουμε τα ομαδοποιημένα κομμάτια για πιο λεπτομερή επεξεργασία.
 
[image: ]
Εικόνα 4. Σημείο τομής ενός clip
Πρέπει να έχουμε υπόψη μας ότι παρόλο που αφαιρέσαμε ένα κομμάτι από ένα σημείο και μετά, δεν σημαίνει ότι το μέρος αυτό δεν είναι πλέον διαθέσιμο στον χρήστη. Εναλλακτικά αντί για να αποκόψουμε με την μέθοδο slice ένα κομμάτι, μπορούμε να αφαιρέσουμε μέρος από την αρχή ή το τέλος ενός clip με το τριμμάρισμα. Τοποθετώντας το ποντίκι ακριβώς πάνω στο όριο του Clip μπορούμε να κάνουμε μικρο-αλλαγές (trimming)  αλλάζοντας τα όρια του clip, ώστε για παράδειγμα, το μέρος να τελειώνει πιο μετά ή πιο πριν, έχοντας διαθέσιμο το υπόλοιπο video από αυτό που κόψαμε καθώς το πρόγραμμα το κρατάει στην μνήμη.
[bookmark: _Toc379814234]2.3.3	Dissolve In/Out
Στα σημεία που τελειώνει ένα clip είναι απαραίτητο να ομαλοποιήσουμε την είσοδο/έξοδο της εικόνας από το μονόχρωμο καρέ για αισθητικούς λόγους. Έτσι όταν τελειώσουμε με τα κοψίματα εφαρμόζουμε Dissolve in και out στο video μας. Το dissolve δημιουργεί μια ομαλή αλλαγή του opacity από την στιγμή που ξεκινάει ένα clip και άρα την σταδιακή εμφάνιση της εικόνας του clip. Στην ουσία το dissolve είναι ένα ομαλό ‘σβήσιμο’ της εικόνας στο μονόχρωμο καρέ που υφίσταται ως υπόβαθρο. Όπως φαίνετε στην Εικόνα 5 τοποθετούμε το ποντίκι στην πάνω δεξιά ή αριστερά γωνία αντίστοιχα του clip ώστε να ρυθμίσουμε την καμπύλη dissolve στο video κανάλι: 
           [image: ]        [image: ]
Εικόνα 5. Δημιουργία Dissolve-Fade in/Out στην αρχή/τέλος ενός clip.
[bookmark: _Toc379814235]2.3.4	Cross-dissolve
Σε κάποιες περιπτώσεις όπου ένα clip, διαφορετικό συνήθως σε περιεχόμενο, διαδέχεται σε σειρά ένα άλλο, στο ίδιο κανάλι θέλουμε να αποφύγουμε την απότομη αλλαγή καρέ από την μία εικόνα στην άλλη. Με άλλα λόγια χρειάζεται να συνδεθούν σε μια σειρά δύο διαφορετικά πλάνα αλλά με ομαλό τρόπο. Σε αυτήν την περίπτωση δίνεται η επιλογή να δημιουργήσουμε ένα ταυτόχρονο Dissolve In/Out μεταξύ των δύο διαδοχικών clip έτσι ώστε να σβήσει η μία εικόνα μέσα από την επόμενη που εμφανίζεται. Το Sony Vegas πραγματοποιεί αυτή την διαδικασία, ονομαζόμενη και cross-dissolve, αυτόματα εάν μετακινήσουμε ένα clip πάνω από ένα άλλο ενώ στο σημείο διασταύρωσης των clip εμφανίζονται η καμπύλες ομαλής μετάβασης που αναφέρθηκαν προηγουμένως (Εικόνα 6).
 [image: ]
Εικόνα 6. Δημιουργία Cross-Dissolve μεταξύ δύο διαδοχικών clip.
[bookmark: _Toc379814236]2.3.5	Χρήση μεταβάσεων
Εναλλακτικά αντί για ένα απλό σβήσιμο μεταξύ δύο πλάνων, μπορούμε να χρησιμοποιήσουμε μηχανισμούς μεταβάσεων, με γεωμετρικά σχέδια. Το Sony Vegas προσφέρει τέτοιους μηχανισμούς στην καρτέλα ‘Transitions’. Για να εφαρμόσουμε ένα σχέδιο μετάβασης σε μια περιοχή ‘σβησίματος’ επιλέγουμε το αντίστοιχο σχέδιο και το τοποθετούμε στην αντίστοιχη περιοχή. Ο χρόνος διάρκειας της μετάβασης εξαρτάται φυσικά από τον χρόνο διάρκειας ενός σβησίματος ή από τον χρόνο αλληλοεπικάλυψης δύο διαφορετικών clip.
[bookmark: _Toc379814237]  2.4	Οπτικά εφέ (Virtual FX)
Συχνά ανάλογα με τις συνθήκες καταγραφής και φωτισμού είναι αναγκαία η βελτιστοποίηση της εικόνας στο στάδιο της μετα-παραγωγής. Για να το επιτύχουμε αυτό έχουμε στην διάθεση μας εργαλεία οπτικών εφέ (VFX).
Σε αρκετές περιπτώσεις η εικόνα του βίντεο μας δεν είναι καθαρή, είναι σκοτεινή ή έχει αλλοιώσεις στα χρώματα. Έτσι αναγκαστικά επεμβαίνουμε χρησιμοποιώντας οπτικά εφέ. Αυτή η διεργασία είναι εφικτή με την χρήση εφέ στα κανάλια βίντεο αλλά είτε και σε κάποιο clip ξεχωριστά.
[bookmark: _Toc379814238]2.4.1	Διόρθωση φωτισμού και αντίθεσης (Brightness - Contrast)
Ξεκινώντας με τα βασικά δύο παράμετροι στις οποίες μπορούμε να παρέμβουμε είναι αυτές της φωτεινότητας (Brightness) και της αντίθεσης (Contrast). Σε ένα κανάλι βίντεο του Sony Vegas προσθέστε το εφέ ‘Brightness & Contrast’. Αυξάνοντας την πρώτη η εικόνα μας γίνεται πιο φωτεινή ενώ επηρεάζοντας την δεύτερη δημιουργούμε μεγαλύτερη αντίθεση μεταξύ των χρωμάτων κάνοντας τα πιο έντονα. Ωστόσο η υπερβολική τους χρήση μπορεί να οδηγήσει σε ανεπιθύμητα αποτελέσματα και έτσι οι αλλαγές που κάνουμε συνήθως πρέπει να είναι μικρές.
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Εικόνα 7 Αύξηση του Contrast σε μια εικόνα.
Στην Εικόνα 7 προσθέσαμε ένα ποσοστό αντίθεσης (contrast) ώστε να τονιστούν τα χρώματα, τα οποία αρχικά ήταν εξασθενημένα. Στην επεξεργασμένη έκδοση (δεξιά) παρατηρούμε ότι οι τόνοι των χρωμάτων είναι πιο έντονοι. Ταυτόχρονα μπορούμε να χαμηλώσουμε ελάχιστα και τη φωτεινότητα. Την φωτεινότητα επίσης πρέπει να αυξήσουμε όταν ένα βίντεο είναι σκοτεινό.
[bookmark: _Toc379814239]2.4.2	Διόρθωση χρωμάτων (Color Correction)
Αντίστοιχα με την διόρθωση της φωτεινότητας & του κοντράστ με την χρήση VFX μπορούμε να επέμβουμε στα χρώματα ή στο επίπεδο των χρωμάτων με το εφέ ‘Color Correction’. Το περιβάλλον διεπαφής παρουσιάζεται στην Εικόνα 8.
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Εικόνα 8 VFX Plugin Color Correction
Στο περιβάλλον διεπαφής του εφέ ‘Διόρθωσης Χρωμάτων’ αρχικά διακρίνουμε τρεις ‘δίσκους’. Ο κάθε δίσκος αντιπροσωπεύει μία περιοχή τόνου χρωμάτων, χωρισμένη στα βασικά χρώματα ανά τετράδες. Κάθε χρώμα έχει και το αντίστοιχο συμπληρωματικό του, καθώς τα συμπληρωματικά χρώματα βρίσκονται αντιδιαμετρικά στον δίσκο. Από αριστερά προς τα δεξιά ο πρώτος ρυθμίζει την ποσότητα ενός χρώματος στην περιοχή του μαύρου, ο μεσαίος στην περιοχή ενός συγκεκριμένου γκρί και ο τρίτος στην περιοχή του άσπρου. Κάθε δίσκος έχει ένα δείκτη ο οποίος βρίσκεται αρχικά στο κέντρο. Μετατοπίζοντας τον δείκτη προς ένα χρώμα, επηρεάζουμε το Hue για την συγκεκριμένη περιοχή τόνου, ανάλογα με την μετατόπιση. Για παράδειγμα εάν μετατοπίσουμε τον δείκτη προς το πράσινο στις χαμηλές περιοχές, οι μαύρες ή και σκούρες περιοχές θα αλλάξουν προς το πράσινο.
Κάτω από κάθε δίσκο αριστερά και δεξιά συναντάμε δύο εργαλεία σταγονόμετρου χρώματος (eyedropper). Το συγκεκριμένο εργαλείο γενικά όταν επιλεχθεί και τοποθετηθεί πάνω σε ένα οποιοδήποτε pixel μιας εικόνας αναγνωρίζει το συγκεκριμένο χρώμα του pixel. Ωστόσο το κάθενα από τα δύο έχει και διαφορετική χρήση. Το αριστερό ‘σταγονόμετρο’ λειτουργεί εντοπίζοντας το συμπληρωματικό χρώμα από αυτό που διαλέξαμε. Πχ. εάν το τοποθετήσουμε σε ένα σημείο που έχει κόκκινο, ο δείκτης στον δίσκο θα μετατοπιστεί αυτόματα προς το μπλε. Το δεξί σταγονόμετρο διαθέτει την εξής διαφορετική λειτουργία. Επιλέγοντας το πάνω σε ένα pixel ή σε μια περιοχή της εικόνας, εμφανίζει στον χρωματικό δίσκο το αντίστοιχο χρώμα. Αυτό μας είναι χρήσιμο όταν θέλουμε να βρούμε ένα χρώμα και να το εξαλείψουμε ή να το αλλάξουμε σε μια συγκεκριμένη περιοχή.
Κάτω από τους δίσκους χρώματος συναντάμε τις παραμέτρους Saturation, Gamma, Gain και Threshold. Η παράμετρος Saturation αυξάνει ή μειώνει το ποσοστό χρώματος στην εικόνα. Για παράδειγμα εάν κατεβάσουμε την παράμετρο στο 0 τότε η εικόνα μας θα μετατραπεί σε ασπρόμαυρη. Αντίστροφα εάν αυξήσουμε την παράμετρο τότε τα χρώματα θα γίνουν πιο έντονα.
Η παράμετρος Gamma καθορίζει την σχετική φωτεινότητα (Brightness) της εικόνας. Την χρησιμοποιούμε αν θέλουμε να κάνουμε τα χρώματα πιο ανοιχτά ή πιο σκούρα.
Η παράμετρος Threshold έχει λειτουργία παρόμοια με αυτή της παραμέτρου Gamma. Επηρεάζει την εικόνα όσον αφορά την φωτεινότητα (luminance) αλλά σε διαφορετικό επίπεδο. Το Luminance σαν παράμετρος ορίζει την απόλυτη φωτεινότητα σαν μέγεθος σε αντίθεση με την υποκειμενική φωτεινότητα (Brightness) που βλέπει τον ανθρώπινο μάτι. Αντιλαμβανόμαστε σε μια εικόνα την απόλυτη φωτεινότητα (Luminance), εάν αφαιρέσουμε τελείως τα χρώματα. Σαν παράμετρος το Luminance εξαρτάται παράλληλα και από το Brightness αλλά και το Contrast. Τέλος ο δείκτης Gain επηρεάζει το ποσό του Luminance.  
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Εικόνα 9 Διόρθωση χρωμάτων σε στιγμιότυπο διάλεξης πριν και μετά
Στην Εικόνα 9 έχουμε το στιγμιότυπο από τα σεμινάρια του Μεγάρου Μουσικής Αθηνών. Στην αριστερή εικόνα είναι το στιγμιότυπο χωρίς επεξεργασία ενώ στην δεξιά αφότου έχουμε εφαρμόσει την διόρθωση χρωμάτων. Οι ρυθμίσεις που χρησιμοποιήσαμε για το συγκεκριμένο παράδειγμα απεικονίζονται στην Εικόνα 10. Άμα παρατηρήσουμε προσεκτικά στην αρχική εικόνα, πέρα από το ξεθώριασμα των χρωμάτων έχουμε μια ελαφριά τάση προς το γαλάζιο ειδικά στην υψηλή περιοχή. Για να αντισταθμίσουμε αυτή την χρωματική τάση θα τοποθετήσουμε τους δείκτες μας προς την αντιδιαμετρική πλευρά, δηλαδή προς το κόκκινο. 
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Εικόνα 10 Ρυθμίσεις διόρθωσης χρωμάτων για το στιγμιότυπο της Εικόνας 8.
[bookmark: _Toc379814240]2.4.3	Markers – Regions – Loops
Θέλοντας να κάνουμε πιο εύκολη την ζωή μας όσον αφορά την οργάνωση του project μας και την εξαγωγή σε τελικά αρχεία υπάρχουν οι λειτουργίες των region και markers.
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Εικόνα 11 Χρήση Regions και Markers
Markers (πάνω δεξιά) μπορούμε να δημιουργήσουμε πολύ εύκολα τοποθετώντας τον play cursor σε ένα   σημείο στο timeline και έπειτα πατάμε το πλήκτρο ‘M’. Χρησιμοποιούμε τους markers για τον ορισμό σημείων ενδιαφέροντος, όπως πχ εισαγωγή, μέρος 1, 2 κλπ. Αντίστοιχα για να ορίσουμε μια region (πάνω αριστερά) επιλέγουμε με drag του ποντικιού μια περιοχή στο timeline. Αυτή η περιοχή ορίζεται ως περιοχή loop. Έπειτα με το πλήκτρο ‘R’ την ορίζουμε σαν Region.
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Εικόνα 12 Ενδείξεις χρόνου των ορίων λούπας και συνολικός χρόνος λούπας.
	Η χρησιμότητα των markers και region βρίσκεται και στην εξαγωγή σε video που θα δούμε αργότερα. Επίσης το πρόγραμμα μετράει τους χρόνους ανάμεσα σε μια loop περιοχή. Συνεπώς εάν μας ενδιαφέρει πόσο διάρκεια έχει μια περιοχή απλά την επιλέγουμε ανάμεσα στους markers ή την region και έπειτα βλέπουμε τον χρόνο κάτω δεξιά. 
 


[bookmark: _Toc379814241]3.	Ήχος
[bookmark: _Toc379814242]3.1	Γενικές αρχές
	Η διαδικασία της επεξεργασία του ήχου λαμβάνει χώρα και αυτή στο περιβάλλον του Sony Vegas. Ωστόσο οι ίδιες διαδικασίες μπορούν να πραγματοποιηθούν και σε άλλα λογισμικά τα οποία ειδικεύονται αποκλειστικά σε αυτό όπως το Audacity, το Adobe Soundbooth, το Cubase κα. Σε αυτήν την περίπτωση χρειάζεται να εξάγουμε το ηχητικό μέρος σε αρχεία της μορφής .wav ή .mp3 και να το κάνουμε import στο αντίστοιχο πρόγραμμα. Η εξαγωγή ή encoding γίνεται με την χρήση του Sony Vegas ή κάποιου άλλου λογισμικού encoding όπως το Adobe Media Encoder. Η εξαγωγή αρχείων από το Sony Vegas  περιγράφεται στο 4ο κεφάλαιο αυτού του εγχειριδίου.
Στο κομμάτι του ήχου τα πράγματα είναι διαφορετικά με την εικόνα. Ισχύει πάλι η επεξεργασία και διαχείριση των συμβάντων σε ξεχωριστά κανάλια. Ωστόσο όσα κανάλια και να έχουμε (ενεργά) όλα μιξάρονται σε ένα κεντρικό (master) κανάλι. Η μίξη είναι βασική διαδικασία στον ήχο και ορίζει την ανάμειξη των πολλαπλών ήχων σε έναν συνολικό. Το τελικό αποτέλεσμα της μίξης εξαρτάται ανάλογα από την ένταση του κάθε καναλιού.
[bookmark: _Toc379814243]3.2	Editing - Μίξη – Στάθμες

[bookmark: _Toc379814244]3.2.1	Editing - Trimming
Όπως αναλύσαμε το editing στο κομμάτι του βίντεο, αντίστοιχα οι ίδιες λειτουργίες λαμβάνουν χώρα και στο κομμάτι του audio. Ωστόσο είναι απαραίτητο να αναφέρουμε κάποιες διαφορές μεταξύ των δύο περιπτώσεων. Σε αντίθεση με το video ο ήχος είναι μια κυματομορφή με μεταβλητό πλάτος. Εάν λάβει χώρα μια απότομη αλλαγή στην ένταση (της τάξεως των μερικών mseconds) τότε το αποτέλεσμα ακούγεται άσχημα στο ανθρώπινο αυτί. Ένα τέτοιο φαινόμενο ονομάζεται “click” ή “pop” στην ορολογία των ηχοληπτών και είναι μια περίπτωση που αποφεύγεται ‘δια ροπάλου’ στην επεξεργασία. Γι’ αυτό τον λόγο είναι αναγκαίο οι αλλαγές μεταξύ των ηχητικών μερών ή το τέλος κάθε μέρους να γίνονται ομαλά.
Στον ήχο η αντίστοιχη διαδικασία σβησίματος - ομαλής μείωσης/αύξησης ονομάζεται Fade In/Out. Αντίστοιχα η ομαλή μετάβαση μεταξύ δύο διαδοχικών ηχητικών μερών ονομάζεται Cross-fade. Προσοχή: Στην εικόνα δεν είναι απαραίτητο να έχουμε πάντα cross-dissolve ενώ αντίθετα στον ήχο είναι επιτακτικό έστω και για ένα διάστημα της τάξεως των 100 msecs!
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Εικόνα 12 Fade Out σε ένα ηχητικό μέρος. Είναι εμφανές ότι η ένταση στην κυματομορφή μειώνεται ομαλά μέχρι να μηδενιστεί στο τέλος.
[bookmark: _Toc379814245]3.2.2	Στάθμες (Μίξη)
Κατά την διάρκεια του σταδίου της μίξης κρίνεται αναγκαίο να αλλάξουμε την στάθμη ενός καναλιού είτε επειδή είναι πολύ δυνατά ή το αντίθετο. Για να αλλάξουμε την ένταση του ήχου έχουμε δυο επιλογές. Η πρώτη δίνεται από τη μπάρα (fader) που βρίσκετε στις ιδιότητες του καναλιού που μας ενδιαφέρει. Αυτός ο slider επηρεάζει την καθολική ένταση του καναλιού συνεπώς ότι ηχητικά μέρη βρίσκονται εντός αυτού επηρεάζονται.
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Εικόνα 13 Αλλαγή του slider έντασης ενός track.
	Αντίστοιχα από τη μπάρα Master μπορούμε να αυξήσουμε την συνολική ένταση όλων των καναλιών. Προσοχή η ένταση δεν πρέπει να ξεπεράσει τα 0 db. Σε αυτήν την περίπτωση, στο master fader αλλά και στους μετρητές έντασης των tracks εμφανίζεται μια κόκκινη ένδειξη. Σε αυτήν την περίπτωση λέμε ότι το σήμα ψαλιδίζει (clipping) άρα και επιβάλλεται να χαμηλώσουμε την ένταση. 
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Εικόνα 14 Αλλαγή στάθμης στο Master Track
Ή δεύτερη μέθοδος είναι αλλάζοντας την ένταση στο ίδιο το clip. Τοποθετώντας το ποντίκι στο πάνω όριο ενός clip και κάνοντας drag αλλάζουμε την ένταση του ίδιου του μέρους. Με αυτόν τον τρόπο αλλάζει και η ένταση στο εσωτερικό του clip όπως και διακρίνεται στο γράφημα της κυματομορφής.
Οι παραπάνω περιπτώσεις μας επιτρέπουν να αλλάξουμε την ένταση σε ένα μόνο μέρος ή να αλλάξουμε την ένταση σε κάποια μέρη, χωρίς όμως να υπάρχει η εξάρτηση από τον χρόνο. Γι’ αυτό τον εξεζητημένο λόγο υπάρχουν τα envelopes (η ίδια λειτουργία εφαρμόζεται και για την opacity ενός video). Επιλέγοντας ένα track ή clip πηγαίνουμε στο μενού Insert -> Audio envelopes -> Volume. Τότε εμφανίζεται στο clip μια μπλε γραμμή στην οποία μπορούμε να προσθέσουμε σημεία αλλαγής τα οποία μπορούν να μετακινηθούν κάθετα & οριζόντια.
 [image: ]
Εικόνα 15 Αυτοματοποίηση της στάθμης έντασης με την χρήση καμπύλης envelope.
[bookmark: _Toc379814246]3.3	Χρήση ψηφιακών εφέ
Κατόπιν του σταδίου της αποκοπής και της μίξης σειρά έχει η χρήση ψηφιακών εφέ. Τα ψηφιακά εφέ εφαρμόζονται είτε σε ένα track καθολικά είτε σε ένα clip. Λειτουργούν σε πραγματικό χρόνο ή μη και στόχο έχουν να διαμορφώσουν τα χαρακτηριστικά του ήχου που θέλουμε. Η διαμόρφωση βασικών χαρακτηριστικών του ήχου όπως η ένταση και η συχνότητες κρίνονται απαραίτητες στην διαδικασία της μίξης καθώς κατά την διαδικασία της παραγωγής χρειάζεται να αυξήσουμε ή να μειώσουμε ορισμένες παραμέτρους σχετικές με τα χαρακτηριστικά αυτά. Φυσικά οι αλλαγές των παραμέτρων καθορίζουν και την βελτιστοποίηση της ποιότητας του ψηφιακού υλικού. Επίσης η χρήση ψηφιακών εφέ είναι αναγκαία για την αποθορυβοποίηση, διαδικασία για την οποία θα μιλήσουμε αναλυτικά στην παράγραφο 3.4.
Η χρήση ψηφιακών εφέ πρακτικά περιλαμβάνεται στις host εφαρμογές, όπως το Sony Vegas, με την ύπαρξη δευτερευόντων εφαρμογών οι οποίες ονομάζονται plug-in. Οι εφαρμογές plug-in συνήθως κυκλοφορούν στο εμπόριο ή στην ελεύθερη αγορά ως ξεχωριστά αρχεία βιβλιοθηκών (.dll), οι οποίες λειτουργούν μόνο σε συνδυασμό με μια ενιαία πλατφόρμα όπως τα κεντρικά προγράμματα επεξεργασίας ήχου και βίντεο. Για λόγους λειτουργικότητας η πλατφόρμα ανάπτυξης των αρχείων-βιβλιοθηκών αυτών (VST) είναι ενιαία και καθιστά τα plug-in συμβατά με τις περισσότερες εφαρμογές παραγωγής ήχου ή βίντεο.
[bookmark: _Toc379814247]3.3.1	Χρήση δυναμικών εφέ - Compressor
Εκτός από την χρήση των faders για την αλλαγή της στάθμης υπάρχει πιο εξεζητημένος τρόπος για την εξομάλυνση των εντάσεων και αυτή είναι η χρήση δυναμικών εφέ όπως ο compressor.
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Εικόνα 16 Κομπρέσορας plug-in της σειράς Waves
Ο κομπρέσορας χρησιμεύει σε περιπτώσεις που οι αλλαγές εντάσεων είναι συνεχείς σε ένα μέρος και θέλουμε να τις εξισορροπήσουμε χωρίς να κάνουμε αλλαγές στο envelope. Κυρίως συμμαζεύει δυνατά σημεία (peak) της κυματομορφής μας. Ωστόσο ένα μειονέκτημα του είναι ότι ανεβάζει τον θόρυβο υποβάθρου. Ανοίγουμε λοιπόν το παράθυρο με τα εφέ και προσθέτουμε τον compressor της Sony ή τον C1 των Waves. Οι λειτουργίες τους είναι πανομοιότυπες. Κυρίως μας ενδιαφέρουν οι παράμετροι Threshold και Ratio (Amount).
Η παράμετρος Threshold ορίζει σε ποια στάθμη θα αρχίζει να εφαρμόζεται η συμπίεση (μείωση της έντασης αναλογικά). Από το όριο αυτό και κάτω δεν επηρεάζεται η ένταση. Από το όριο και πάνω η ένταση μειώνεται σε σχέση με την παράμετρο Ratio. Όσο μεγαλύτερη είναι αυτή η παράμετρος τόσο πιο πολύ μειώνεται η ένταση η οποία ξεπερνάει το όριο του Threshold. Κοινώς μεγαλύτερο amount σημαίνει και ότι στο δυνατό σημείο θα μειωθεί η ένταση και θα εξισορροπηθεί με το υπόλοιπο σήμα. Λογικά όταν συμπιέζουμε ένα ακουστικό σήμα μειώνεται η συνολική ένταση. Έτσι στο τέλος αυξάνουμε είτε το Output Gain (Makeup) ή το volume στο κανάλι μας.
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 Εικόνα 17 Κομπρέσορας plugin του Sony Vegas
	Τέλος για να αποφύγουμε το ‘ψαλίδισμα’ (clipping) της έντασης τοποθετούμε στο master κανάλι το εφέ της συλλογής plug-in Waves Maximizer. Ο Maximizer λειτουργεί σαν compressor θέτοντας το ανώτατο όριο στα dB. Έτσι αν το σήμα ψαλιδίζει αυτόματα το συμπιέζει και αποτρέπει από το να φτάσει τα 0 dB (το όριο ψαλιδίσματος).
[bookmark: _Toc379814248]3.3.2	Χρήση ισοσταθμιστή - EQ
Κατά την διαδικασία επεξεργασίας οπτικοακουστικού υλικού σε αρκετές περιπτώσεις χρειάζεται να ενισχύσουμε ή να εξασθενήσουμε συγκεκριμένες περιοχές συχνοτήτων. Για παράδειγμα ενδέχεται να χρειάζεται η αφαίρεση ενός συνεχή ήχου, σε μία ηχητική καταγραφή, που εντοπίζεται σε συγκεκριμένη περιοχή συχνοτήτων. Η αφαίρεση/πρόσθεση συχνοτήτων σε αυτήν την περίπτωση γίνεται στα πλαίσια της αποθορυβοποίησης ή για να βελτιωθεί/ξεχωρίσει η χροιά πχ μιας ομιλίας. Η επέμβαση σε συχνότητες επιτυγχάνεται με ισοσταθμιστές ή Equalizers (EQ).
Οι ισοσταθμιστές είναι ψηφιακά εφέ, σαν τον κομπρέσορα, τα οποία όμως επιδρούν στο φασματικό περιεχόμενο του ήχου, δηλαδή στην ένταση του ήχου σε συγκεκριμένες συχνότητες. Ένας ισοσταθμιστής αποτελείται από ένα ή παραπάνω φίλτρα. Οι κύριες παράμετροι ενός φίλτρου είναι η συχνότητα επίδρασης και η ενίσχυση ή αποκοπή στην συχνότητα αυτή. Συνήθως χρησιμοποιούνται παράλληλα πολλά φίλτρα με διαφορετικές παραμέτρους το καθένα σε διαφορετικά σημεία του ακουστικού φάσματος. Το ακουστικό φάσμα χωρίζεται σε μπάντες. Οι ακουστικές μπάντες σε αντιστοιχία με την τοποθέτησή τους στην κλίμακα των συχνοτήτων, χωρίζονται σε μπάσα (χαμηλά), χαμηλο-μεσαία, ψηλο-μεσαία και πρίμα (ψηλά).
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Εικόνα 18 Χρήση Paragraphic EQ plugin στο Sony Vegas.
Η χρήση των EQ στις εφαρμογές επεξεργασίας γίνεται είτε με plug-in εφαρμογές σε πραγματικό χρόνο αλλά είτε και με την χρήση ‘εσωτερικών’ effects σε μη πραγματικό χρόνο. 
	Η λειτουργία των ισοσταθμιστών στηρίζεται στα φίλτρα. Φίλτρα έχουμε πολλών ειδών. Τα κυριότερα που θα μας απασχολήσουν είναι τα παρακάτω:
1. Αποκοπής ηψηλών ή χαμηλών συχνοτήτων ή αντίστοιχα διέλευσης χαμηλών ή ηψιλών συχνοτήτων (High/Low cut και αντίστοιχα Low/High Pass). Τα φίλτρα αυτά αποκόπτουν όλες τις συχνότητες πάνω (High cut) ή κάτω (Low cut) απο τη συχνότητα αποκοπής τους. Κύρια παράμετρός τους είναι η συχνότητα αποκοπής.
2. Τύπου ραφιού υψηλών ή χαμηλών συχνοτήτων (High/Low shelving). Τα φίλτρα αυτά ενισχύουν ή εξασθενούν τις συχνότητες στα άκρα του φάσματος. Το υψηλών από την συχνότητα επίδρασής τους και πάνω και των χαμηλών από τη συχνότητα επίδρασής τους και κάτω. Κύριες παράμετροί τους είναι η απολαβή (ενίσχυση ή εξασθένιση) και η συχνότητα επίδρασης.
3. Τύπου κορυφής (peaking). Τα φίλτρα αυτά εξασθενούν ή ενισχύουν μια στενή περιοχή γύρω από τη συχνότητα επίδρασής τους. Κύριες παράμετροί τους είναι η απολαβή (ενίσχυση ή εξασθένιση), η συχνότητα επίδρασης και το εύρος επίδρασης γύρων από τη συχνότητα.
Στην Εικόνα 18 φαίνεται το παραμετρικό EQ του Sony Vegas. Σε αυτό σε κάθε μπάντα, από τις τέσσερις υπάρχει δυνατότητα να ρυθμιστεί η συχνότητα - Frequency(Hz), η ενίσχυση ή αποκοπή - Gain (db) και το εύρος συχνοτήτων που επηρεάζεται σε κάθε μπάντα – Bandwidth (oct)
Ένα άλλο είδος ισοσταθμιστή είναι ο λεγόμενος γραφικός ισοσταθμιστής. Σε αυτόν υπάρχουν μπάντες σε συγκεκριμένες συχνότητες και σε κάθε μία μεταβάλλεται η απολαβή.
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Εικόνα 19 Γραφικός EQ plugin στο Sony Vegas.
Οι ισοσταθμιστές είναι χρήσιμοι όταν μας ενδιαφέρει να επεξεργαστούμε μια συγκεκριμένη συχνότητα ή περιοχή συχνοτήτων. Για παράδειγμα όταν θέλουμε να αφαιρέσουμε έναν θόρυβο από ηλεκτρομαγνητικές παρεμβολές του δικτύου τροφοδοσίας, ο οποίος ξέρουμε ότι εντοπίζεται στα 50Hz, θα αποκόψουμε στην συχνότητα αυτή.
Στην προκειμένη περίπτωση των βιντεο-διαλέξεων το ενδιαφέρον μας εστιάζεται πρακτικά στην ομιλία. Το σήμα της ανθρώπινης φωνής εντοπίζεται στην περιοχή συχνοτήτων από 500Hz μέχρι 4kHz περίπου, οπότε στις υπόλοιπες συχνότητες δεν υπάρχει χρήσιμη πληροφορία. Αρχικά μπορούμε έτσι να αποκλείσουμε όλες τις χαμηλές συχνότητες μέχρι τα 200Hz. Με αυτό τον τρόπο αποκόπτονται διάφοροι βόμβοι, γδούποι και ήχοι χειρισμού των συσκευών οι οποίοι δεν προσφέρουν στην καταγραφή της ομιλίας. Ακόμα σε πολλές περιπτώσεις οι συχνότητες πάνω από τα 4-5kHz μπορεί να περιέχουν θορύβους όπως από αέρα, χαρτιά ή γενικότερα ηλεκτρομαγνητικό θόρυβο, οι οποίοι είναι ανεπιθύμητοι. Στην περίπτωση αυτή είναι χρήσιμο να εξεταστεί η αποκοπή συχνοτήτων στην περιοχή αυτή.
Σε πολλές περιπτώσεις η χρήση ισοσταθμιστών μπορεί να συνοδευτεί και με έναν φασματικό αναλυτή όπως στο σχήμα. Σε αυτόν αποτυπώνονται στον οριζόντιο άξονα οι συχνότητες και στον κατακόρυφο η ένταση σε κάθε συχνότητα. Έτσι έχουμε μια καλύτερη εικόνα για το ποιες συχνότητες υπάρχουν στο σήμα μας.
Σε κάθε περίπτωση η χρήση ισοσταθμιστών πρέπει να επιβεβαιώνεται και από το ηχητικό αποτέλεσμα. Δηλαδή οι παραπάνω ενδεικτικές συχνότητες και η οποιαδήποτε ένδειξη του φασματικού αναλυτή πρέπει να μην υπερισχύει της ακουστικής δοκιμής και σύγκρισης του, πριν την επεξεργασία με εκείνο μετά την επεξεργασία.
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 Εικόνα 20 Απεικόνιση φασματικού αναλυτή (Spectrum Analyser).
[bookmark: _Toc379814249]3.3.3	Χρήση φίλτρου εγκοπής (notch filter)
Συχνά στο ηχητικό σήμα μπορεί να υπάρχει ένας ανεπιθύμητος ήχος συγκεκριμένου ύψους όπως κάποιος βόμβος από κλιματισμό ή άλλη μηχανή, κάποιο σφύριγμα ή ακόμα και ηλεκτρομαγνητικός θόρυβος από καλώδια τροφοδοσίας. Σε αυτή την περίπτωση συνίσταται η επεξεργασία με τη χρήση φίλτρου εγκοπής (notch filter) πριν από την αποθορυβοποίηση. 
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Εικόνα 21 Φίλτρο εγκοπής (notch) στο Audacity
Το φίλτρο αυτό αποκόπτει τις συχνότητες γύρω από μια κεντρική. Η κεντρική συχνότητα καθορίζεται από την παράμετρο “Frequency” και το εύρος των συχνοτήτων, που θα αποκόπτονται γύρω από αυτή, δίνεται από την παράμετρο “Q”. Συνίσταται να χρησιμοποιείται ψηλό “Q” της τάξης του 20,0 ώστε να έχουμε αποκοπή μόνο της προβληματικής συχνότητας. Για τη ρύθμιση της παραμέτρου συχνότητας πρέπει να γίνουν δοκιμές ώστε να βρεθεί η κατάλληλη. Γενικά οι πιθανότερες συχνότητες είναι κάτω από τα 3 kHz με πιθανότερες από 40 Hz έως 100 Hz. Για αφαίρεση ηλεκτρομαγνητικού θορύβου από καλώδια τροφοδοσίας η συχνότητα αποκοπής είναι 50Hz ίση με τη συχνότητα ταλάντωσης του δικτύου ηλεκτροδότησης.
[bookmark: _Toc379814250]3.3.4	Χρήση Εξασθενιτή Συριστικότητας – De-esser
Όταν επεξεργαζόμαστε ήχο που περιλαμβάνει ομιλία, παρατηρούμε συχνά την ενοχλητική ενίσχυση του φθόγγου «σίγμα». Αυτό προέρχεται από διάφορους λόγους όπως την χροιά της φωνής του ομιλητή, τα ιδιαίτερα χαρακτηριστικά του μικροφώνου, διάφορες αντανακλάσεις ή γενικότερα συμπεριφορά του χώρου καθώς και κάποιο συνδυασμό όλων αυτών. Το φασματικό περιεχόμενο του φθόγγου «σίγμα» εντοπίζεται γύρω στα 10kHz.
Επειδή η έντονη αποκοπή της συγκεκριμένης περιοχής συχνοτήτων με κάποιο ισοσταθμιστή, θα οδηγούσε σε αλλοίωση της γενικότερης χροιάς αξιοποιούμε τον εξασθενιτή συριστικότητας ή De Esser. Ο De Esser δεν αποκόπτει μία περιοχή συχνοτήτων σαν ισοσταθμιστής, αλλά επιδρά σαν συμπιεστής στη συγκεκριμένη αυτή και την εξασθενεί μόνο όταν αυτή εμφανίζει μεγάλη ένταση όπως με τον φθόγγο «σίγμα».
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Εικόνα 22 De-esser plugin της σειράς Waves.
Οι κύριες παράμετροι του De Esser είναι το κατώφλι «Threshold» και η συχνότητες στην οποία επιδρά. Κατεβάζοντας το κατώφλι καθορίζουμε την ένταση, της περιοχής συχνοτήτων, στην οποία επιδρά ο περιοριστής. Για να αφαιρέσουμε περισσότερη «συριστικότητα» κατεβάζουμε το Threshold. Η συχνοτική περιοχή στην οποία επιδρά καθορίζεται από το ρυθμιστικό "Frequency" και από το αν θα χρησιμοποιηθεί μία ζώνη, γύρω από τη συχνότητα αυτή, ή οι όλες συχνότητες από αυτή και πάνω (Band pass, High pass filter type). 
Στην εικόνα.. φαίνεται το plug-in “Waves DeEsser” στο οποίο η επιλογή της περιοχής συχνοτήτων καθορίζεται από τα ρυθμιστικά “Freq” για τη συχνότητα και “SideChain” για τον τύπο του φίλτρου. Ακόμα πολύ χρήσιμο εργαλείο, σε ένα De Esser, είναι η ακρόαση του «συριστικού» μέρους του σήματος, που έχει επιλεγεί να συμπιέζεται. Με τη λειτουργία αυτή μπορεί να γίνει ακρόαση του τι ακριβώς αφαιρείται έτσι ώστε να εντοπιστεί με ακρίβεια η «συριστικότητα» που θα αφαιρεθεί από το σήμα. Στο plug-in της Εικόνας 22 επιτυγχάνεται με το κουμπί “Side chain” στο μέρος “Monitor”.
[bookmark: _Toc379814251]3.4	Τεχνικές από-θορυβοποίησης
Σε αυτό το κεφάλαιο θα εστιάσουμε σε συγκεκριμένες τεχνικές και λογισμικά που αφορούν το κομμάτι τις αποθορυβοποίησης. Συχνά στο ακουστικό υλικό μας περιέχεται συχνοτικό υλικό το οποίο θεωρείται θόρυβος ή ανεπιθύμητο σήμα. Τέτοιες περιπτώσεις μπορούμε να συναντήσουμε όταν στο περιβάλλον της ηχογράφησης υπάρχουν σταθερές ηχητικές πηγές όπως κλιματισμός, ηλεκτρικές συσκευές, ανεμιστήρες κλπ. Ακόμα μία ξεχωριστή κατηγορία θορύβου είναι ο υψίσυχνος θόρυβος ή αλλιώς Hiss, ο οποίος προέρχεται είτε από την χρήση αναλογικών κυκλωμάτων, είτε όμως και από την εκ των προτέρων κατασκευή του μικροφωνικού εξοπλισμού. Τέλος στην περίπτωση της καταγραφής διαλέξεων υπάρχει και ο θόρυβος υποβάθρου ή θόρυβος περιβάλλοντος.
Η αποθορυβοποίηση λειτουργεί σε δύο στάδια. Κατά το πρώτο αναγνωρίζεται το προφίλ του θορύβου και κατά το δεύτερο αφαιρείται από το ηχητικό σήμα.
[bookmark: _Toc379814252]3.4.1	Αποθορυβοποίηση με το λογισμικό Audacity
Από τη στιγμή που έχει εισαχθεί ένα αρχείο ήχου στο Audacity, ανοίγοντας το μενού ‘Effects’ εμφανίζεται μια λίστα με τα διαθέσιμα εργαλεία επεξεργασίας. Από αυτά θα εξετάσουμε την ‘Απομάκρυνση Θορύβου’ (Noise Removal).
 [image: C:\Users\Peo\Documents\University\OpenCourses\Manuals\screenshots\Audacity_NoiseRemove.png]
Εικόνα 23 Πλαίσιο παραμέτρων εφέ Από-θορυβοποίησης στο Audacity
Αρχικά επιλέγουμε ένα σημείο του ηχητικού σήματός μας το οποίο περιέχει μόνο θόρυβο και όχι ομιλία ή τον ήχο του περιβάλλοντος που μας ενδιαφέρει. Στη συνέχεια επιλέγουμε την ‘Απομάκρυνση Θορύβου’ από τα εργαλεία επεξεργασίας και πατάμε το κουμπί ‘Get Noise Profile’.  Έτσι αναγνωρίζεται το προφίλ του θορύβου.
Στη συνέχεια επιλέγουμε ολόκληρο το ηχητικό σήμα και εφαρμόζουμε πάλι την ‘Απομάκρυνση Θορύβου’. Τα ρυθμιστικά ‘Noise Reduction’ και ‘Sensitivity’ ουσιαστικά καθορίζουν το πόσος θόρυβος θα αφαιρεθεί από το σήμα. Συνίσταται η εκκίνηση από τις προτεινόμενες τιμές των παραμέτρων που φαίνονται στο σχήμα και στη συνέχεια, ανάλογα με την περίπτωση, να ρυθμίζεται πρώτα το ‘Noise Reduction’ και ύστερα το ’Sensitivity’. Οι υπόλοιπες παράμετροι προτείνεται να μην μετακινούνται από τις δοσμένες τιμές. Για τον έλεγχο της επίδρασης των επιλεγμένων παραμέτρων στο σήμα συνίσταται η χρήση του κουμπιού Προεπισκόπησης πριν από την εφαρμογή σε ολόκληρο το αρχείο ήχου.
[bookmark: _Toc379814253]3.4.2	Waves X-Noise
Μία από τις τεχνικές αποθορυβοποίησης σε πραγματικό χρόνο, επιτυγχάνεται με την χρήση του λογισμικού plugin Waves X-Noise. Αφού έχουμε φορτώσει το plugin στο αντίστοιχο track στο Sony Vegas ή σε οποιοδήποτε άλλο λογισμικό, διαλέγουμε μια περιοχή από το υλικό μας η οποία περιέχει μόνο θόρυβο περιβάλλοντος ή τον θόρυβο που χρειάζεται να αφαιρεθεί. Θέτουμε σε λούπα αυτή την περιοχή και πατάμε την επιλογή learn έτσι ώστε το λογισμικό να «μάθει» το προφίλ συχνοτήτων του θορύβου. Κατά την διάρκεια διάγνωσης του προφίλ η ένδειξη learn αναβοσβήνει. Αναπαραγάγουμε την περιοχή λούπας για μερικά δευτερόλεπτα και απενεργοποιούμε την επιλογή learn.
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Εικόνα 24 Το interface επιλογών του Waves Χ-Noise plugin.
Σε αυτό το σημείο είμαστε σε θέση να επέμβουμε στην αφαίρεση του θορύβου έχοντας στην διάθεση μας τις εξής παραμέτρους-επιλογές στο interface της εφαρμογής.
Το Threshold-κατώφλι: Ορίζει από ποια στάθμη και κάτω περνάει το σήμα από το οποίο θα αφαιρεθεί ο θόρυβος. Συνήθως ορίζουμε το κατώφλι στην στάθμη της έντασης του θορύβου. Η παράμετρος Reduction ορίζει το ποσοστό του σήματος θορύβου που θα αφαιρέσουμε από το εισερχόμενο σήμα. Αν ακούγονται ψηφιακά σκουπίδια δοκιμάστε να μειώσετε αυτή την παράμετρο. Ο διακόπτης Audio/Difference μας επιτρέπει ακούμε είτε το τελικό σήμα ή το σήμα που έχει αφαιρεθεί. Με αυτόν τον τρόπο είμαστε σε θέση να διακρίνουμε αν έχουμε αφαιρέσει πολύτιμες συχνότητες από το αρχικό μας σήμα.
Τέλος Στο κομμάτι Dynamics ορίζουμε τους χρόνους attack και release. Οι δύο αυτές μεταβλητές καθορίζουν την χρονική συμπεριφορά του αλγορίθμου στο εισερχόμενο σήμα. Συστήνεται η χρήση των προκαθορισμένων τιμών. Στην εξειδικευμένη περίπτωση που η αφαίρεση οδηγεί στην παραγωγή ψηφιακών απορριμμάτων (artifacts), επιχειρούμε να αλλάξουμε την παράμετρο Attack. Η συγκεκριμένη παράμετρος καθορίζει τον χρόνο έναρξης επίδρασης της αποθορυβοποίησης.
Στο περιβάλλον της εφαρμογής δίνονται επιπρόσθετα η παρακάτω ενδείξεις σε σχετικούς γραφικούς μετρητές.
· NR: Σε αυτή την ένδειξη φαίνεται σε πραγματικό χρόνο το ποσοστό που θεωρείται ως ανεπιθύμητο και αφαιρείται.
· Spectrum Analyzer: Στον αναλυτή φάσματος διακρίνονται με ξεχωριστά χρώματα τρία διαφορετικά σήματα. Με άσπρη γραμμή ορίζεται το προφίλ του θορύβου, με κόκκινη το εισερχόμενο σήμα και με πράσινη το εξερχόμενο (επεξεργασμένο).
[bookmark: _Toc379814254]3.4.3	Αποθορυβοποίηση με Adobe Audition ή Soundbooth
Παρόμοια η ίδια διαδικασία πραγματοποιείται και στο Adobe Audition. Μέσα από τις επιλογές του Vegas μπορούμε να ανοίξουμε σε ξεχωριστή έκδοση αρχείου τον ήχο μας. Έπειτα μέσα στο Audition επιλέγουμε ένα κομμάτι με το θόρυβο που θέλουμε να απομακρύνουμε.
[image: ]
 Εικόνα 25 Επιλογή περιοχής για τον ορισμού προφίλ θορύβου.
Επιλέγουμε με διπλό κλικ από τα menu αριστερά ‘Capture Noise Reduction’. Και μετά ‘Noise Reduction’.
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Εικόνα 26 Μενού επιλογής εφέ αποθορυβοποίησης
Στο παράθυρο ‘Noise Reduction’ κάνουμε τα εξής βήματα: Πατάμε ‘Select entire file’ για να γίνουν οι αλλαγές μας σε όλο το αρχείο που έχουμε εισάγει στο Audition. Επιλέγοντας το ‘Preview’ μπορούμε να ακούσουμε τον ήχο μας με τις αλλαγές που έχουμε εφαρμόσει. Αντίθετα επιλέγοντας το ‘Bypass’ απενεργοποιούμε/ενεργοποιούμε στο ‘Preview’ τις αλλαγές που κάνουμε. Αλλάζοντας τη ρύθμιση ‘Keep only noise’ ακούμε μόνο τον ήχο που θα αφαιρέσουμε ώστε να ελέγχουμε ότι δεν κόβουμε κάτι χρήσιμο.
Οι παράμετροι στις οποίες μπορούμε να επέμβουμε είναι οι εξής:
· Στο πεδίο “Reduce by” ορίζουμε κατά πόση ένταση θα μειώσουμε το θόρυβο.
· Με τη μπάρα “Noise Reduction Level” πόσο θόρυβο θα αφαιρέσουμε από τον ήχο μας.
Όταν τελειώσουμε οποιαδήποτε αλλαγή και είμαστε σίγουροι για το επιθυμητό αποτέλεσμα πατάμε ‘OK’ για να ενεργοποιηθούν οι αλλαγές μας.  
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Εικόνα 27 Ρυθμίσεις αποθορυβοποίησης στο Adobe Audition.
Τέλος στο κεντρικό μενού του Audition πατάμε File -> Save και κλείνουμε το πρόγραμμα και να επιστρέψουμε στο Sony Vegas. Πατάμε File -> Save as αν έχουμε κάποιο πρόβλημα ή θέλουμε να συγκρίνουμε στο Vegas το νέο ήχο με τον αυθεντικό. 
[bookmark: _Toc379814255]3.5	Χρήση του ελεύθερου λογισμικού Audacity
Οι παραπάνω διαδικασίες επεξεργασίας ήχου περιγράφονται με τα χρήση του λογισμικού Sony Vegas. Σαν εναλλακτική επιλογή προτείνουμε την λύση του λογισμικού Audacity. Το Audacity (http://audacity.sourceforge.net/) είναι ένα δωρεάν λογισμικό, ανοιχτού κώδικα, για διάφορα λειτουργικά συστήματα (Windows®, Mac®, GNU/Linux®) για την καταγραφή και επεξεργασία των ήχων. Το συγκεκριμένο λογισμικό επιτρέπει την πολυκάναλη καταγραφή/ηχογράφηση, επεξεργασία και μείξη ηχητικού υλικού. 
Το Audacity δεν υποστηρίζει την εφαρμογή μονάδων επεξεργασίας σε πραγματικό χρόνο αλλά διαθέτει μία συλλογή εργαλείων δυναμικής επεξεργασίας, ισοστάθμισης, αποθορυβοποίησης και άλλων.
Όταν εισάγεται ένα αρχείο ήχου στο Audacity εμφανίζεται ένα παράθυρο όπως αυτό που απεικονίζεται στην εικόνα, το οποίο ρωτάει εάν προτιμάται η δημιουργία αντίγραφου του αρχείου ήχου ή η απ’ ευθείας χρήση του αρχικού αρχείου. Συνίσταται η πρώτη επιλογή ώστε για λόγους ασφαλείας να υπάρχει μη επεξεργασμένο αρχείο.
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Εικόνα 28 Παράθυρο επιλογών εισαγωγής αρχείου στο Audacity
Το Audacity αποθηκεύει τα αρχεία επεξεργασίας του με την επέκταση .aup και τα διαβάζει μόνο το ίδιο. Για να χρησιμοποιήσουμε στην επεξεργασία βίντεο ένα αρχείο ήχου συνήθως χρειάζεται να το έχουμε με την επέκταση .wav. Για να έχουμε την εργασία μας με την επέκταση αυτή πρέπει, από το μενού Αρχείο (File) να επιλέξουμε την ‘Εξαγωγή…’ (“Export…”) και μετά να δώσουμε το όνομα και τη θέση του αρχείου που επιθυμούμε.
Τέλος το Audacity έχει ακόμα την δυνατότητα να εξάγει τον ήχο από ένα αρχείο βίντεο χωρίς να απαιτείται χρήση άλλου προγράμματος για τον λόγο αυτό. Αυτό σημαίνει ότι εάν ανοίξουμε με το Audacity ένα αρχείο βίντεο, αυτό εξάγει αυτομάτως τον ήχο προς επεξεργασία. Ωστόσο συστήνεται η χρήση εξαγωγής των audio αρχείων από το Sony Vegas ή από κάποιο άλλο λογισμικό decoding όπως το Adobe Media Encoder.



[bookmark: _Toc379814256]4.	Εξαγωγή τελικών αρχείων – Render
[bookmark: _Toc379814257]4.1	Γενικά
Στο σημείο αυτό έχουμε ολοκληρώσει όλα τα στάδια της επεξεργασίας και του μοντάζ για το υλικό μας, καθώς σειρά έχει η εξαγωγή σε ένα τελικό αρχείο. Η διαδικασία αυτή ονομάζεται rendering. Το τελικό βίντεο που χρειαζόμαστε για να αναρτήσουμε απαιτείται να διαθέτει συγκεκριμένα χαρακτηριστικά ψηφιοποίησης αλλά και την σωστή κωδικοποίηση ανάλογα με την περίπτωση που θα χρησιμοποιηθεί. 
[bookmark: _Toc379814258]4.2	Κωδικοποίηση - Formats
Συνήθως οι μορφές αρχείων εξαγωγής (coding containers) είναι τα format mpeg, mp4 και wmv. Το πρώτο αποτελεί μια ασυμπίεστη μορφή βίντεο και επιλέγεται στην περίπτωση που θέλουμε να διατηρήσουμε την πληροφορία της ψηφιοποίησης ακέραια. Το δεύτερο και το τρίτο αποτελούν κωδικοποιήσεις συμπίεσης ψηφιακού βίντεο για εξοικονόμηση χώρου και ελαχιστοποίηση της πληροφορίας ψηφιοποίησης. Για την εξαγωγή οπτικοακουστικού υλικού το οποίο θα αναρτηθεί σε ιστοσελίδες χρησιμοποιούμε αποκλειστικά το format mp4 καθώς θεωρείται από τα πιο διαδεδομένα και συμβατά format για αυτή την χρήση.
[bookmark: _Toc379814259]4.2.1	Ρυθμίσεις χαρ/κων κωδικοποίησης
Επί της διαδικασίας εξαγωγής, αφού έχουμε επιλέξει μια loop περιοχή στο timeline, στο κεντρικό  menu του Vegas πατάμε File -> Render As. Στο νέο παράθυρο που άνοιξε διαλέγουμε που θέλουμε να αποθηκευτεί καθώς και το όνομα του νέου video. Στο ‘Save as type’ επιλέγουμε το codec που θα χρησιμοποιήσουμε και πατάμε το κουμπί ‘Custom’. Επίσης ενεργοποιούμε την επιλογή ‘Render Loop Region only’ έτσι ώστε να εξάγουμε μόνο το κομμάτι που έχουμε επιλέξει.
 [image: ]
Εικόνα 29 Παράθυρο διαλόγου για την τελική εξαγωγή βίντεο (render)
Στο νέο παράθυρο, στη καρτέλα ‘video’ ορίζουμε τα εξής κύρια χαρακτηριστικά:
•	την ανάλυση του video, 
•	το frame rate 
•	το bit rate.
•	και το Pixel aspect ratio 
Συνήθως την ανάλυση του video την αφήνουμε την ίδια με το αρχικό. Ειδάλλως βάση της αναλογίας ύψους – πλάτους συμπληρώνουμε την αντίστοιχη ανάλυση. Για περισσότερες πληροφορίες σχετικά με τις διαθέσιμες αναλύσεις και τους συντελεστές αναλογίας μπορεί κάποιος να ανατρέξει στο Internet. Αν απαιτείται να χρησιμοποιηθούν οι ρυθμίσεις του αυθεντικού video, πρέπει να το ανοίξουμε  με τον Media Player Classic και να πάμε File -> Properties στη καρτέλα ‘Details’ και να αντιγράψουμε τις ρυθμίσεις στο Vegas. Εναλλακτικά στα Project Media του Vegas κάνοντας δεξί κλικ και Properties πάλι βλέπουμε τα στοιχεία του αρχικού video. 
 [image: ]
Εικόνα 30 Παράθυρο custom ρυθμίσεων για την εξαγωγή.
Στην περίπτωση του mp4 codec χρησιμοποιούμε ως Profile την επιλογή ‘main’ για να εξασφαλίσουμε συμβατότητα αναπαραγωγής του video. Στην παράμετρο frame rate θέτουμε 15 fps για multimedia video ή 25 για video PAL-DV. Η τελευταία ρύθμιση θεωρείται η ελάχιστα ικανοποιητική στο ανθρώπινο μάτι για ένα καλής ποιότητας βίντεο. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η τιμή του FR να ορίζεται στα 20 fps. Συμπληρωματικά για να διατηρήσουμε το μέγεθος των pixel και κατ’ επέκταση το τελικό ορθογώνιο προβολής ρυθμίζουμε το Pixel Aspect Ratio ανάλογα με την κατηγορία ανάλυσης διαστάσεων που έχουμε επιλέξει προηγουμένως. Το σωστό αποτέλεσμα κρίνεται φυσικά και αν δούμε το τελικό βίντεο. Εάν στο τελικό βίντεο παρατηρούνται μαύρα παραλληλόγραμμα κενά, εκατέρωθεν της κεντρικής εικόνας, τότε σημαίνει ότι κάποια ρύθμιση δεν έχει γίνει σωστά στην αναλογία του κάδρου, στην ανάλυση ή στο Pixel Aspect Ratio.
Σειρά έχει η παράμετρος bit rate η οποία καθορίζει τον ρυθμό bit ανά δευτερόλεπτο. Όσο μεγαλύτερο είναι το bit rate τόσο περισσότερη πληροφορία περιέχει το ψηφιοποιημένο υλικό μας. Ένα βίντεο καλής ποιότητας πρέπει να έχει bit rate από 1,5 Mbps και πάνω, ειδικά αν πρόκειται για αναπαραγωγή από τον σκληρό δίσκο. Για τις προδιαγραφές χαμηλών πολυμεσικών παραγωγών δηλώνουμε variable bit rate, με μέση τιμή 384 kbps έτσι ώστε το συνολικό video να έχει γύρω στα 500 kbps μαζί με τον ήχο. Σε αυτή την περίπτωση το χαμηλό bit rate σε σχέση με το προαναφερόμενο όριο οφείλεται στο γεγονός ότι το υλικό θα χρησιμοποιηθεί για streaming στο διαδίκτυο. Αν η εικόνα και η ευκρίνεια του τελικού αποτελέσματος δεν είναι ικανοποιητική τότε αυξάνουμε το bit rate. Επίσης οι τιμές bit rate διαφέρουν ανάλογα με την ανάλυση κάδρου. Σε μεγάλες αναλύσεις, όπως HD, απαιτείται μεγαλύτερο bit rate  από αυτά που αναφέρονται παραπάνω. Για τις ανάγκες των Ανοικτών Ψηφιακών Μαθημάτων προτείνεται η τιμή του bit rate να ορίζεται στα 750 kbps.
Τέλος στην καρτέλα audio, με την προϋπόθεση ότι είναι στερεοφωνική η αναπαραγωγή, ορίζουμε τον sample rate στα 22.050 Hz (για απλή ομιλία ενώ για μουσική πρέπει είναι 44.100 Hz) και το bit rate στα 96 kbps για απλή ομιλία ή στα 128 kbps για πιο σύνθετους ήχους.
[bookmark: _Toc379814260]4.3	Πολλαπλή εξαγωγή αρχείων – Batch Rendering
Η διεργασία του rendering είναι μια διαδικασία η οποία απαιτεί αρκετό χρόνο και υπολογιστική ισχύ, ανάλογα με τις δυνατότητες ενός μηχανήματος και την διάρκεια ενός βίντεο. Συνεπώς είναι καλό η διαδικασία αυτή να λαμβάνει χώρα όταν ο υπολογιστής δεν χρησιμοποιείται πχ κατά την διάρκεια της νύχτας. Για την εξοικονόμηση πολύτιμου χρόνου στο Sony Vegas υπάρχει δυνατότητα πολλαπλής-διαδοχικής εξαγωγής αρχείων (batch rendering).
Η δυνατότητα αυτή προσφέρεται μέσα από την γλώσσα scripting του Sony Vegas. Η διαδικασία μπορεί να εφαρμοστεί μόνο σε ένα συγκεκριμένο project της εφαρμογής, για διάφορες περιοχές-Regions (ξεχωριστά κομμάτια βίντεο). Σε ένα ανοιχτό project του Vegas έχουμε επεξεργαστεί πολλαπλά κομμάτια βίντεο τα οποία θέλουμε να τα εξάγουμε ξεχωριστά σε αρχεία. Αρχικά πρέπει να ορίσουμε Regions με την μέθοδο που περιγράφηκε στην παράγραφο 2.4.3. Αφού έχουμε ορίσει Regions πατάμε στο menu Tools -> Scripting -> Batch Render όπου και βρίσκεται έτοιμη η αυτοματοποιημένη διεργασία για batch rendering (Εικόνα 31).
 [image: ]
Εικόνα 31 Επιλογή script για Batch render
	Στη οθόνη επιλογών που εμφανίζεται ορίζουμε τον φάκελο και τον τύπο εξαγωγής όπως ακριβώς περιγράφηκε στην παράγραφο 4.2. Στις επιλογές που εμφανίζονται στο κάτω μέρος του παραθύρου επιλέγουμε ‘Render Regions’. Με αυτή την επιλογή το πρόγραμμα αυτόματα ‘βλέπει’ όλα τα Regions που έχουμε ορίσει και δημιουργεί ένα αρχείο για κάθε region. Σημείωση: Οι τελικές ονομασίες των αρχείων έχουν το όνομα που έχουμε ορίσει στο παράθυρο της Εικόνας 32 συν έναν αύξοντα αριθμό για κάθε περιοχή. Ο αύξων αριθμός καθορίζεται από την σειρά των region στο project.
 [image: ]
Εικόνα 32 Παράθυρο επιλογών Batch render
[bookmark: _Toc379814261]4.4	Demuxing mp4 (βίντεο από IP κάμερες)
Η παράγραφος αυτή αναφέρεται στην διαδικασία επεξεργασίας και μετατροπής video mp4 αρχείων που έχουν καταγραφεί από τις IP κάμερες των αμφιθεάτρων. Τα video αυτά χρησιμοποιούν B-frames με αποτέλεσμα να μην είναι συμβατά με τα προγράμματα επεξεργασίας ή να  χάνουν frame. Όταν αναπαράγουμε ένα τέτοιο αρχείο με τον Media Player ο ήχος είναι ασυγχρόνιστος δυσανάλογα με το βίντεο. Αυτό σημαίνει ότι η καθυστέρηση του ήχου σε σχέση με την εικόνα δεν είναι σταθερή. 
[bookmark: _Toc379814262]4.4.1	Μετατροπή αρχείου
Πριν ξεκινήσουμε την επεξεργασία πρέπει να γίνει demux, με το πρόγραμμα Avidemux. Διαφορετικά θα έχουμε ασυγχρόνιστο ήχο ή δεν θα μπορούμε να επεξεργαστούμε το video.
Ανοίγουμε την εφαρμογή Avidemux και εισάγουμε το video είτε με drag & drop, είτε με File -> Open. Το πρόγραμμα θα μας ρωτήσει αν θέλουμε να αλλάξουμε mode: 
 [image: ]
Εικόνα 33 Επιλογή mode στο Avidemux κατά την εισαγωγή ενός αρχείου mp4
 [image: ]
Εικόνα 34 Επιλογές για την διαδικασία demux
Επιλέγουμε “No” (Εικόνα 33). Στη συνέχεια επιλέγουμε Video -> Copy, Audio -> Copy, Format -> Mp4 (Εικόνα 34).
Τέλος, από τα μενού επιλέγουμε File -> Save -> Save video και αποθηκεύουμε το video μας με νέο όνομα (πχ. Lecture_date_demuxed.mp4). Πλέον είμαστε σε θέση να εισάγουμε το νέο αρχείο στο Sony Vegas και να το επεξεργαστούμε κανονικά.
[bookmark: _Toc379814263]4.5	Χρήση Preset
Για να επιταχύνουμε τη διαδικασία επεξεργασίας για πολλά όμοια κομμάτια είναι καλό να χρησιμοποιούμε έτοιμες ρυθμίσεις στα εφέ μας. Πάνω σε κάθε plugin εφέ υπάρχει ένα πλαίσιο όπου ο χρήστης μπορεί να επιλέξει ή να δημιουργήσει τις δικές του «προεπιλεγμένες ρυθμίσεις». Έτσι αν για παράδειγμα μαγνητοσκοπούμε μια αίθουσα με συγκεκριμένες συνθήκες φωτισμού και ακουστικής, τότε την πρώτη φορά που επεξεργαζόμαστε το υλικό αυτό αποθηκεύουμε τις ρυθμίσεις στα εφέ μας ώστε να χρησιμοποιηθούν αργότερα. Η ίδια διαδικασία εφαρμόζεται και στην διαδικασία εξαγωγής αρχείων.


 

[bookmark: _Toc379814264][bookmark: _Toc356228602]Παράρτημα 
[bookmark: _Toc379814265]Χρήσιμα Link
· http://library.creativecow.net/articles/devis_andrew/Color-Correction-1_Premiere-Pro/video-tutorial
· http://www.sonycreativesoftware.com/support/trainingvids.asp?prod=vegas
· http://www.digitalfaq.com/guides/video/introduction-restore-video.htm
· http://www.thetonesystem.com/color_correction.html
· http://www.sonycreativesoftware.com/colorcorrectionwebinar?keycode=9500-9500
[bookmark: _Toc356228603][bookmark: _Toc379814266]Βιβλιογραφία
· Sony Vegas 12 Operation Manual
· Lighting for Digital Video and Television By John Jackman
· Modern Recording Techniques By David Miles Huber, Robert E. Runstein
[bookmark: _Toc356228604][bookmark: _Toc379814267]Προτεινόμενα VST plugin ελεύθερης αγοράς
· FreqAnalyst από την Blue Cat Audio
· Triple EQ από την Blue Cat Audio
· Spitfish De-Esser από την digitalfishphones
· Blockfish Compressor από την digitalfishphones
· TT Dyna 
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Σημείωμα Αναφοράς
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Σημείωμα Αδειοδότησης
Το παρόν υλικό διατίθεται με τους όρους της άδειας χρήσης Creative Commons Αναφορά Παρόμοια Διανομή 4.0 [1] ή μεταγενέστερη, Διεθνής Έκδοση.
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Η άδεια αυτή ανήκει στις άδειες που ακολουθούν τις προδιαγραφές του Oρισμού Ανοικτής Γνώσης [2], είναι ανοικτό πολιτιστικό έργο [3] και για το λόγο αυτό αποτελεί ανοικτό περιεχόμενο [4]. 
[1] http://creativecommons.org/licenses/by-sa/4.0/deed. el
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Διατήρηση Σημειωμάτων
Οποιαδήποτε αναπαραγωγή ή διασκευή του υλικού θα πρέπει να συμπεριλαμβάνει:
· Το Σημείωμα Αναφοράς
· Το Σημείωμα Αδειοδότησης
· Τη δήλωση διατήρησης Σημειωμάτων
· Το σημείωμα χρήσης έργων τρίτων (εφόσον υπάρχει)
μαζί με τους συνοδευόμενους υπερσυνδέσμους.
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Το έργο “Ανοικτά Ακαδημαϊκά Μαθήματα στο Πανεπιστήμιο Αθηνών” υλοποιείται στο πλαίσιο του Επιχειρησιακού Προγράμματος «Εκπαίδευση και Δια Βίου Μάθηση» και συγχρηματοδοτείται από την Ευρωπαϊκή Ένωση (Ευρωπαϊκό Κοινωνικό Ταμείο) και από εθνικούς πόρους.
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